# Amarra Junior Version 2.2 User Manual Table Of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Manual</td>
<td>3</td>
</tr>
<tr>
<td>1.0.0 Thank you!</td>
<td>4</td>
</tr>
<tr>
<td>2.0.0 Minimum System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>3.0.0 Installing Amarra Junior</td>
<td>5</td>
</tr>
<tr>
<td>3.1 Uninstalling Amarra Junior</td>
<td>9</td>
</tr>
<tr>
<td>4.0.0 Authorization Of Your Amarra Product</td>
<td>10</td>
</tr>
<tr>
<td>4.1.0 Authorizing Amarra Junior After Evaluation Period Expires</td>
<td>12</td>
</tr>
<tr>
<td>5.0.0 Launching and Using Amarra Junior</td>
<td>13</td>
</tr>
<tr>
<td>5.1.0 Amarra Junior Application Menus</td>
<td>15</td>
</tr>
<tr>
<td>5.1.1 The Amarra Junior Menu</td>
<td>15</td>
</tr>
<tr>
<td>5.1.2 The File Menu</td>
<td>15</td>
</tr>
<tr>
<td>5.1.3 The Windows Menu</td>
<td>17</td>
</tr>
<tr>
<td>5.1.4 The Help Menu</td>
<td>17</td>
</tr>
<tr>
<td>6.0.0 Amarra Junior Interface Module</td>
<td>18</td>
</tr>
<tr>
<td>6.1.0 Using Amarra Junior and iTunes</td>
<td>18</td>
</tr>
<tr>
<td>6.1.1 Amarra EQ and iTunes EQ Presets</td>
<td>20</td>
</tr>
<tr>
<td>6.2.0 FLAC Conversion and Playback</td>
<td>20</td>
</tr>
<tr>
<td>6.2.1 Convert FLAC File to AIFF</td>
<td>21</td>
</tr>
<tr>
<td>6.2.2 Convert FLAC Folder to AIFF</td>
<td>21</td>
</tr>
<tr>
<td>6.2.3 FLAC File Playback Using A Playlist</td>
<td>21</td>
</tr>
<tr>
<td>6.5.0 Amarra Background Manager</td>
<td>22</td>
</tr>
<tr>
<td>6.5.1 SOUNDFILES</td>
<td>22</td>
</tr>
<tr>
<td>6.5.2 PROCESSING</td>
<td>23</td>
</tr>
<tr>
<td>6.6.0 Amarra Junior Preferences</td>
<td>23</td>
</tr>
<tr>
<td>6.6.1 Launch Settings</td>
<td>24</td>
</tr>
<tr>
<td>6.6.2 Playback Settings</td>
<td>24</td>
</tr>
<tr>
<td>6.6.3 Dither Settings</td>
<td>24</td>
</tr>
<tr>
<td>6.6.4 Processing Settings</td>
<td>25</td>
</tr>
<tr>
<td>6.6.5 Sonic Hardware Settings</td>
<td>25</td>
</tr>
<tr>
<td>7.0 Registering Your Amarra Junior Software</td>
<td>25</td>
</tr>
<tr>
<td>8.0 Upgrades to Amarra MINI and Amarra</td>
<td>26</td>
</tr>
<tr>
<td>9.0 Troubleshooting Guide</td>
<td>27</td>
</tr>
<tr>
<td>10.0 Support</td>
<td>33</td>
</tr>
<tr>
<td>11.0.0 Amarra Team Contact Info</td>
<td>34</td>
</tr>
</tbody>
</table>
About This Manual

This manual, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of such license. The information in this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Sonic Studio, LLC. Sonic Studio, LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in this book. Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Sonic Studio, LLC.

Notice of Liability

The author and publisher have made every effort to ensure the accuracy of the information herein. However, the information contained in this document is provided without warranty, either express or implied. Neither the authors, Sonic Studio, LLC, nor its dealers or distributors will be held liable for any damages to be caused either directly or indirectly by the instructions contained in this book, or by the software or hardware products described herein.

SONIC STUDIO, LLC MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. SONIC STUDIO, LLC DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SONIC STUDIO, LLC SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SONIC STUDIO SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL SONIC STUDIO, LLC, ITS DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SONIC STUDIO SOFTWARE EVEN IF SONIC STUDIO HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Notice of Rights

©2009 -2011 Sonic Studio, LLC — All rights reserved. No part of this document may be reproduced, stored in a retrieval system or transmitted in any form or by any means, without the prior written permission of the publisher. Sonic Studio, Amarra, Amarra Junior, Amarra Junior, SSE, NoNOISE native, Sonic EQ, Model 302, Model 303, Model Four, Model 305 and the Sonic Studio and Amarra logos are trademarks of Sonic Studio, LLC. All other company or product names are either trademarks or registered trademarks of their respective owners.
1.0.0 Thank you! ::

Thank you for purchasing the Amarra Junior Computer Music Player. You are about to enjoy the ultrafidelity sound of Amarra. Designed to work with your Apple™ MacIntosh Computer and with iTunes, Amarra Junior provides a seamless integration for high resolution music playback.

The Amarra Team
Sonic Studio, LLC
330 Sir Frances Drake Blvd, Suite A
San Anselmo, CA USA 94960-2552
phone: 1-415-480-1601
www.amarraaudio.com
support@sonicstudio.com

This document details the installation of Amarra and its associated software.

The Amarra Junior 2.2 installer will install the following items on to your Macintosh Computer:

- Amarra Junior Computer Music Player
- Amarra Documentation
- Amarra iTunes Plugin
- FLAC Component

2.0.0 Minimum System Requirements ::

Computer:
- Intel based Mac with 10.5.x, or 10.6.x
- NOTE: PPC (G5) Macs are no longer supported. New licensing method is not recognized. Use 2.1.1.
- RAM: 3 GB RAM minimum, 4 GB or more preferred
- Amarra
- iTunes

Supported Audio Hardware Interfaces:
- Most Core Audio Interface will work with Amarra. This includes USB, FireWire, and optical connections on the Macintosh. Please visit the Hardware section of www.amarraaudio.com for more information.

Peripheral FireWire Adaptors supported:
- OHCI compliant PCCard, PCI card, ExpressCard or PCIe card

Software:
- Mac OS X 10.5.x or 10.6.x and above recommended
  NOTE: 10.4.X supported for uncompressed files only
• Amarra Junior
• iTunes

We recommend a fresh install of the operating system on a clean disc. This can prevent problems later on.

We also highly recommend that your computer be used exclusively for music playback. Email, web browsers, screen sharing and other applications can all affect performance.

3.0.0 Installing Amarra Junior ::

The Amarra Junior installer will install the following items on to your Macintosh Computer:
• Amarra Junior 2.2 Computer Music Player
• Amarra Junior iTunes Plugin
• Amarra Junior FLAC components
• Amarra Junior Documentation

Double-click on the Amarra Junior Installer that you downloaded. This screen appears:

• Select Continue.
End User License Agreement.
Please take a moment to read this important document, then select Continue.

Select Agree to continue installing Amarra Junior.
Select Install to complete the Amarra Junior installation process.

Enter your password and click on OK.
Amarra and all of its components are installed.

- Amarra Junior application is installed into the Applications folder.
  It is installed here: ~/Applications/Amarra Junior 2.1
- The Amarra iTunes Plugin facilitates the interaction between Amarra and iTunes.
  It is installed here: ~/Library/iTunes/iTunes Plug-ins/
- Amarra Junior installs the FLAC components required for FLAC file playback
  They are installed here: ~/Library/Components/
Success!

Select the Close button to quit the Amarra Junior installer.

3.1 Uninstalling Amarra Junior

To uninstall Amarra Junior and remove all files please run the “Uninstall Amarra Junior.app” located in the Extras Folder. This will remove the application, iTunes plug-in, and FLAC component. You may be prompted for your password.
4.0.0 Authorization Of Your Amarra Product ::

Amarra Junior is licensed for use via a simple Internet Authorization process. Please follow the steps below to Authorize your Amarra software. Also see Section 8 of this document for answers to questions regarding our authorization process.

Your Amarra Product is licensed for use via a simple Internet Authorization process. Please follow the steps below to Authorize your Amarra Product.

1) When you launch your Amarra Product the first time, you will be presented with the Authorization dialog box, Figure 1, below.

![Authorization dialog box](image)

Figure 1: Authorization dialog box.

**Evaluate button:** Allows an Amarra product to run in Evaluation Mode for a specific time. Your email address is required.

**Activate button:** Securely sends your Activation Code, email address and unique password to authorize your Amarra Product.

**Deactivate button:** Deactivates your Amarra product on the current computer and allow you to Activate Amarra on another computer.

**Send Password button:** Sends the password you define to the email you provided.

**Buy button:** Takes you to an online store to purchase Amarra.

**OK button:** Cancels and closes the Authorization window.
2) Enter information into the provided fields..

A) Copy and Paste your Activation code into the Activation Code area.
B) Add your email address and create your own unique password in the appropriate fields. (Figure 2)
C) Click on the Activate button to activate your Amarra product.

IMPORTANT NOTE:
If you purchase Amarra Junior after April 15, 2011, your new Activation Code is delivered to you via email.
If you purchased Amarra Junior before April 15, 2011, use your Amarra product Serial Number as your Activation Code.

Figure 2: Sample Authorization dialog box with all fields filled out.

Success! Your Amarra Software has been authorized.
NOTE: When you reactivate a new release of Amarra, or move Amarra to another computer you will be asked for a new password. The window below will appear, type in a new password and click ‘OK’.

Be sure to store your password in a safe place for future reference.

Enter a new password to reactivate your copy of Amarra.

4.1.0 Authorizing Amarra Junior After Evaluation Period Expires ::

After the Evaluation period has expired, it’s easy to receive an Activation Code that enables you to continue to enjoy the ultrafidelity sound of Amarra forever. Simply select the Buy button and you will be directed to an online store to purchase an Amarra product of your choice.

Your Activation Code will be sent to you via email. Once you receive your Activation Code, follow the steps outlined above to authorize your copy of an Amarra product.

Information About The Amarra Authorization Process ::

Activation is a set of simple and quick steps taken after your purchase of Amarra. It entitles you to use Amarra on your computer. If you’ve purchased products online or installed many of the Adobe products you have already used a similar activation system. When your application is authorized it contacts a central server across the internet to ‘activate’ your software and tie it to the provided activation code (which is generally provided by email).

This anti-piracy system helps protect your investment in Amarra and enables us to continue its development at a competitive price. The license protection and monitoring system is managed by software_DNA from softWORKZ Innovation Inc. This system does not collect any details about you or your computer during license activation and re-activation.
Unlike other activation systems, the software DNA system for Amarra does not tie your license permanently to your computer hardware. Instead, your license is tied to your activation code and password that you define. As a result, you will have no problem re-activating your software after reformating your hard drive, after upgrading hardware components in your computer, or when you move your software to a new computer. However, activation and re-activation does require an Internet connection. This Internet connection can be on a different computer from where your application is installed.

5.0.0 Launching and Using Amarra Junior ::

Open the Applications folder on your Mac, locate the Amarra Junior folder. This folder contains the Amarra Junior application as well as documentation and an Extras folder.

![Amarra Junior Application folder](image)

NOTE: Launch Amarra Junior first, not iTunes. Double clicking on the Amarra Junior icon launches Amarra Junior and iTunes.

HINT: Install a shortcut for Amarra Junior on your Dock.:

- Locate the Amarra Junior.app icon.
- Click once and hold the icon then drag to the dock.
- The Dock for your system will appear.
- Place (drop) the Amarra Junior icon and release on the dock.
- You can move its location within the Dock later.
NOTE: When you launch iTunes, Amarra Junior will automatically launch. Likewise, when iTunes quits Amarra Junior will be shutdown. In iTunes under Visualizer Plugin there is an Options menu command which can be used to disable the auto launch / quit feature.

Access Amarra Junior Preferences from the Amarra Junior Menu

Amarra Junior Preferences Window showing the LAUNCH/QUIT ITUNES checkbox.
5.1.0 Amarra Junior Application Menus ::

5.1.1 The Amarra Junior Menu:

The Amarra Junior Menu:
About Amarra Junior: Opens the modal About window. This is useful for verifying the version number of Amarra Junior that you are running. Click anywhere in the window to close it.
Preferences [Cmd+,:]: Opens the Preference window for Amarra. See Section 6.6.0 for more information.
Services: This menu proves access to any Services that are available to Amarra Junior. Services extend an application or frameworks functionality by sharing its capabilities with other programs.
Hide Amarra Junior: Hides all Amarra Junior windows. To reveal the windows, click on the Dock icon or tap the +tab key to cycle through running applications to select Amarra Junior.
Hide Others [option+,+h]: Hides all windows other than Amarra Junior.
Show All: Reveals all windows.
Quit Amarra Junior [,+q]: Quits Amarra Junior.

5.1.2 The File Menu:

Convert FLAC File to AIFF...: Navigate to a FLAC file in the Finder and convert them to AIFF format.
Convert FLAC Folder to AIFF...: Navigate to a folder containing FLAC files and convert the folder’s content to AIFF.
Authorization...: Opens the Amarra Authorization window. See section 4 of this document for more information.

Extras:

Audio MIDI Set Up: Opens the Audio MIDI Set Up Window. This is useful for verifying connection to your DAC.
Rescan I/O: Forces Amarra Junior to query Core Audio for current interface status.
Set Playback To Amarra [Cmd+1]: Sets the source for playback as Amarra.
Set Playback To iTunes [Cmd+2]: Sets the source for playback as iTunes.
Toggle Mute: Mutes and unmutes the main volume control.

Cut: Cuts the currently selected string or item to the Clipboard.
Copy: Copies the currently selected string or item to the Clipboard.
Paste: Pastes the currently selected string or item from the Clipboard.
(for use with Authorization)

Enable Debugging: This is useful for providing Sonic Studio technicians important information regarding Amarra should any issues arise.
Send Crash Report: Send important information to Sonic Studio technicians.

System Console Log: Opens Apple's Console app. This is useful for providing Sonic Studio technicians important information regarding Amarra should any issues arise.

NOTE: Toggling between Cmd+1 and Cmd+ 2 is a good way to compare the sound quality between Amarra and iTunes.
Togglle Mute: Mutes and unmutes the main volume control.

5.1.3 The Windows Menu:

Amarra [opt+a]: Opens the main Amarra window.
iTunes [opt+i]: Opens the main iTunes window.
Background Manager: Opens the Amarra Background Manager window.

5.1.4 The Help Menu:

6.0.0 Amarra Junior Interface Module ::

The Amarra Junior’s control interface module features are explained below:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1. Time Display</strong></td>
<td><strong>2. Transport Controls</strong></td>
</tr>
<tr>
<td>The Time Display shows the current time in the track.</td>
<td>The Previous Track, Play/Pause, and Next Track buttons are located here.</td>
</tr>
<tr>
<td><strong>3. iTunes Lock</strong></td>
<td></td>
</tr>
<tr>
<td>This keeps Amarra Junior locked to iTunes (when moved)</td>
<td></td>
</tr>
<tr>
<td><strong>4. Volume Control/Sample Rate display</strong></td>
<td><strong>5. Amarra/iTunes Indicator</strong></td>
</tr>
<tr>
<td>The Volume Slider controls the volume. Sample Rate of soundfile is displayed (96 kHz max.)</td>
<td>Indicates playback status: Blue = Amarra is playing Grey = iTunes is playing Orange = iTunes is playing a protected file.</td>
</tr>
<tr>
<td><strong>6. Amarra EQ</strong></td>
<td></td>
</tr>
<tr>
<td>Amarra EQ enabled based on iTunes EQ Preset for the Track. Loaded preset is displayed.</td>
<td></td>
</tr>
</tbody>
</table>

**TIP:** Use the Arrow keys to adjust the volume. Use the Option-Arrow key for fine adjustment.

**TIP:** Use the Volume control on your Apple Remote or on iTunes to control the volume.

**TIP:** Want to hear that wonderful instrumental section again? Stop Amarra Junior, double-click in the seconds area of the Time Display section and use the down arrow to back up 1 second per key stroke. Hit the spacebar to start play at the new time selection.
6.1.0 Using Amarra Junior and iTunes

Amarra Junior runs alongside Apple’s iTunes program. This allows you to manage and access all your music through the main iTunes Music Library or through custom iTunes Playlists.

As shown below, Amarra Junior occupies the area to the left of your iTunes window:

Amarra Junior and iTunes side by side.

You can use iTunes like you always have, select the songs or a playlist and play. Amarra Junior follows what you do in iTunes and takes over playback of:

- Full resolution uncompressed 44.1 (16 or 24 bit) AIFF or WAV files
- Most compressed MP3 files
- ALAC, FLAC or AAC files
- Redbook CDs at 44.1 kHz sample rates

NOTE: Amarra Junior can not play Protected AAC files. Instead, Amarra Junior uses iTunes for playback those files.
6.1.1 Amarra EQ and iTunes EQ Presets

Amarra Junior will use the EQ settings from iTunes for your Tracks and set the superior-sounding Amarra EQ to match. The small indicator to the right of the Time Display will turn Blue when the EQ is engaged.

![Amarra Junior interface showing EQ settings](image)

The EQ engaged based on setting from iTunes Track Information (iTunes EQ is accessible using Get Info in iTunes on the selected Track).

6.2.0 FLAC Conversion and Playback

In addition to playing back native FLAC natively, Amarra Junior supports conversion routines for FLAC. Using the FLAC conversion routines under the FILE menu it is possible to convert FLAC files or entire folders of FLAC files to AIFF files and to add them to iTunes automatically.

Converting FLAC files to AIFF files allows iTunes to find and add metadata for album artwork, artist and song titles as an example.
The File menu in Amarra showing the Convert FLAC file to AIFF... and Convert FLAC Folder to AIFF... commands.

6.2.1 Convert FLAC File to AIFF

This command launches the built-in FLAC to AIFF conversion routine.

You will be prompted to locate the files to convert and to specify a destination folder to store the converted files. You will also be asked whether you would like to add the files to iTunes after they are converted.

6.2.2 Convert FLAC Folder to AIFF

This command launches the built-in FLAC to AIFF conversion routine. You will be prompted to locate a folder to convert and to specify a destination folder to store the converted files. You will also be asked whether you would like to add the files to iTunes after they are converted.

6.2.3 FLAC File Playback Using A Playlist

To play FLAC files, use the “Open Tracks From Finder” command and navigate to the FLAC files you wish to play. The FLAC files you choose will be added to a playlist.

TIP: Save your FLAC Albums as a Playlist for easy playback.
6.5.0 Amarra Background Manager

The Background Manager is used to perform Sample Rate Conversion, FLAC to AIFF Conversion and monitor the status of those conversions.

Amarra Junior comes with a high quality Sample Rate Conversion. Sample Rate Conversion preserves pitch and duration of the original sound file and will create a new soundfile with a 44100 Hz sample rate. Amarra Junior supports the ability to convert a file to a variety of sample rates to 44100 hz. An additional Quality field is provided as well. A higher quality will take a longer time to process.

There are different parameters in this window, each is described below:

6.5.1 SOUNDFILES

The ADD FILES button can be used to add files to be sample rate converted. You can drag AIFF or WAV files into this window. Information on the file will be displayed in the INFO field. You can set a destination folder or use the default folder which is set to the same folder as the original file.

6.5.2 PROCESSING

Once files are added you can start the Sample Rate conversion using the Execute button. The progress will be shown along with the name of the destination file.
This section presents an overview of the Amarra MINI Preferences.

**LAUNCH SETTINGS**

**LAUNCH / QUIT ITUNES**: Forces iTunes to launch or quit in sync with Amarra Junior.

**HIDE ON LAUNCH**: Forces Amarra Junior to hide its windows after startup.

**LINK ITUNES WINDOW**: Forces iTunes to remain ‘attached’ to Amarra’s main window, regardless of the main window’s location.

**LINK ITUNES EQ PRESETS**: Forces Amarra to follow the EQ settings in iTunes.

**PLAYLIST FOLLOWS ITUNES**: Forces Amarra’s Playlist to follow the track selections in iTunes.

**PLAYBACK SETTINGS**

**BYPASS COMPRESSED FILES**: Forces Amarra to skip over lossy encoded music files like MP3 and AAC.

- Useful for PPC Macs.

**TRACKS TO LOAD**: Sets the number of consecutive tracks that Amarra pulls from iTunes when auto-populating a Playlist.

**MEMORY AMOUNT**: Set the amount of Random Access Memory that Amarra uses to temporarily store audio in Cache Mode.

**DITHER SETTINGS**

**AUTO-DITHER**: Automatically enables redithering when Amarra’s gain is not set to unity or 0.

**TYPE**

- **TPDF**: Sets Amarra’s redithering function to Sonic Studio’s proprietary Shaped TPDF (Triangular Probability Density Function) dither type.
- **MBIT+**: Sets Amarra’s redithering function to iZotope’s proprietary MBIT+ dither type.
- **Shape**: When Type is MBIT+, sets the amount of spectral shaping, from none to extreme.
- **Wordlength**: Sets the number of bits for Amarra’s output. This setting should match your DAC’s word length specification. If set to less than 24 bits, Auto-dither should be enabled for best quality.

**PROCESSING SETTINGS**

**FULL SONIC-EQ**: Changes the Equalizer from iTunes,Äistyle generic curves to fully adjustable, minimal phase Sonic EQ. Not available in Amarra MINI or Junior.

**Pure Gain**: Forces Amarra to change gain in 1 bit steps for less gain interpolation and higher quality.

**Hard Limit**: Changes the way Amarra reproduces consecutive over samples. Recommended for music with limited dynamic range.

**SONIC HARDWARE SETTINGS**

- Requires Sonic Studio Hardware.
- **Launch/Quit Console**: Forces Sonic Console to launch or quit in sync with Amarra.
- **Dim Front Panel**: Dims the front panel display.
- **Control Volume**: Interlocks Amarra,Äos gain control with the hardware gain control so either can be used.
- **Gain Adjustment**: Set the system gain to match professional (0 dB) or consumer electronic (-10 or -14 dB) standard levels.
7.0 Registering Your Amarra Junior Software ::

In order to receive warranty service, you must register your product with Sonic Studio. This may be done at any time with proof-of-purchase.

We strongly recommend that you register with Sonic Studio as soon as you purchase your software. This will ensure the best possible support and keep your advised of new Amarra Junior releases.

NOTE: We value your privacy. Your contact information will not be shared with any third party.

1. Your product will be registered with us.
   Registration is used as proof of ownership if your product is ever lost or stolen.
2. Sonic Studio updates Amarra Junior software on a regular basis.
   This allows us to keep you informed of updates as they become available.

Please register your Amarra Junior software using our automated registration Web page at:

http://www.sonicstudio.com/register

Alternatively, our mail address is:

Amarra Software registration
Sonic Studio, LLC
330 Sir Frances Drake Blvd  Suite A
San Anselmo, CA USA
94960-2552
Phone: +1-415-480-1601
Fax 1-775-330-8923

If you encounter issues using Amarra Junior please refer to the troubleshooting information below for assistance. If none of these steps address your problem please contact your dealer or Sonic Studio support for more help.

8.0 Upgrades to Amarra MINI and Amarra ::

The policy for upgrading from Amarra Junior to Amarra is the difference in price. Please contact Sonic Studio or your local Amarra representative for ordering information.
9.0 Troubleshooting Guide ::

Basic Macintosh Setup Tips

iTunes:
• Disable the Crossfade Songs preference in iTunes
• Disable the Sound Enhancer preference in iTunes
• Disable the Sound Check preference in iTunes

Energy Preferences:
• Disable Sleep and other Energy saving Preferences.

Spotlight:
• Disable Spotlight

Security:
• Disable Infrared

Time Machine:
• Disable TimeMachine on your media drives.

Folder Actions:
• Disable All Folder Actions

Also:
• We recommend a fresh install of the operating on a clean disc.

• We also highly recommend that your computer be used exclusively for music playback, and that all unnecessary devices be disabled.

• Email, web browsers, screen sharing and other applications will affect performance. They should not be running when using Amarra Junior.

See below for answers to common issues.

Issue: Amarra Authorization Answers.

I have entered my code and password correctly with a new password to do a re-activation, why is the application not being re-activated?
Verify that you have an Internet Connection. Your new password must be a new and never-used password. Verify that you have not previously used this password with this activation code.

**How often will my application connect to the activation server via the Internet?**

Your application uses the Internet when it is first installed, when it is re-activated (such as after a disk reformat and reinstall, or if the software is moved to a new computer). The application may also do a quick check with the server when you run the application.

software_DNA includes an anti-fraud system that disables activation codes in cases of credit-card chargeback or refund. Unless you are using offline activation (see below), your application will need to connect to the Internet at least once a month to verify the license status. When an activation code is revoked, the software remains in trial mode until a new, valid activation code is provided.

**Will my application work if I don't have an Internet connection?**

Yes, there is an offline activation method available. If no Internet connection is found during activation, or the activation server is not reachable, the software will ask you to do offline activation. The software will provide step-by-step instructions, where a file is written to disk that you move to a computer that does have Internet access (or email access). You can move this file via LAN, floppy disk, CD-R or USB key. You can use your Internet browser (on a machine that does have Internet access) to visit a special page to upload this file and receive another file in return. If you do not have any working browsers then the file can be emailed to our tech support (note there may be a delay in the return of the file depending on the time of day and week).

**During activation what information is passed to the server?**

No personal information or information about your computer configuration are transferred. There is a one-way hash* of some machine configuration data, your chosen password, and the optional email address sent to the server. Your application may have an optional registration page and if you choose to fill that out, that information is also transferred during the first activation. If you do not provide the optional information (email address and registration information) then no personal information will be transferred. We suggest you do not use one of your important personal passwords for the activation password, or a password that personally identifies you.

*One-way Hash: Codes that identify parts of the computer are put through a special function (called a ‘one way hash’) that turns the codes into one code number that is unique to your computer but cannot be deciphered (or reverse engineered) to determine what those components are. Only this hash value is sent to the activation server and not the details on the
Can I move Amarra to another computer?

Yes, this can be done easily. It is simply a matter of deactivating the application on one computer, reinstalling the application on the new machine, and reactivating the software. If you have remembered your password this will be a fast and easy process.

What is the email address for and is it mandatory?

The email address on the activation and reactivation dialogs is mandatory. It can be used to retrieve a lost password. When you provide the email address it will not be used for marketing purposes or sold / provided to any third party. If you do provide an email address we recommend it be one that will be active for some time.

What if I have forgotten my password and did not provide an email address (or my email address is no longer valid)?

During a reactivation the previously provided password is required. If the password has been lost and cannot be recovered (because an email address was not provided, or the email address is no longer valid) you will need to contact our support via email or by phone. We will be happy to reset your password.

Will changes to my computer cause my application to stop working?

There are no changes that will cause a permanent disabling of the software. Major changes (disk reformat being one such major change) will mean that you need to reactivate the software. If you have your password this will be a fast and easy process.

What happens if Sonic Studio or softWORKZ suspends service or goes out of business?

Both companies have been in business for several years, and are healthy and stable and will be around for many years to come!

Regardless, your activated application will continue working without the Activation server, although new activations or re-activations will not be possible. Both companies are committed to ensure that a patch will be made available ASAP to resolve this. Either a version with a replaced activation system or a version with no activation will be provided.
I wish to do an online activation but my firewall is set up to block such requests. What are the firewall settings?

The following is the information that you need to setup your firewall:
  Main server IP address: reg1.softworkz.com
  Backup server IP: reg2.softworkz.com
  Backup server IP: reg3.softworkz.com
  Port: 80 (Standard HTTP)
  Domain: softworkz.com

Why is an activation system required at this time?

Software companies around the world have come to realize that activation-type copy-protection systems provide a reasonable solution to the problem of piracy while at the same time respecting customers by not burdening them with a hard-to-use licensing system. Reducing piracy means that the software vendor can use steady revenues to further improve the product and guarantee business continuation. It is unfortunate that piracy exists because we know the majority of our customers follow the license terms but it is a fact of life in this digital age. We trust that this new system will be virtually transparent for the majority of customers.

Issue:
Amarra Junior does not run without authorization.
Amarra Junior has not been authorized. A valid Amarra license can not be found.

Solution:
  • Authorize your software using with an Authorization Code.
  • License your product
  • Please refer the Licensing section of this document for more information.

Issue:
Amarra Junior fails to operate or run.

Solution:
  • Amarra Junior requires a license to operate
Issue:
How to set up a remote volume or hard drive

Amarra does not support streaming of remote songs. Amarra requires that all volumes/drives be mounted on the computer as a shared volume.

Solution:
• Mount the remote volume with Read/Write Access on your local Macintosh - Use the Network (Cmd-K) to locate and mount the remote volume
• In iTunes use the Add to Library command to add the songs from the Mounted Volume
• Mount the remote volume with Read/Write Access on your local Macintosh

Issue:
Audio Clicking or Ticking Sound.

Solution:
Disable Spotlight (add volumes to the Spotlight Privacy Preference)

Open System Preferences and locate the Spotlight Preference pane:

Select the Privacy Tab and add all your media drives:
Solution:

Disable Network Shared Access.
Open System Preferences and locate the Sharing Preference.

Disable Web Sharing, Remote Login and Remote Management.

NOTE: For Sonic Studio Remote Support Services, the Remote Management preference may be required.

Solution:

- Disconnect multiple FireWire devices
- Reduce daisy-chained connections
- Use a FireWire hub

Solution:

- Shut down other applications such as email and browsers.

Solution:

- Increase the amount of RAM in your computer.

Solution:

- Check that all drives are HFS formatted. Amarra does not support FAT32 drives.
• Change the Sample Rate manually using Audio Midi Setup to a different value. Then switch the Sample Rate back.

**Issue:**
Songs do not change or sound correctly.

**Solution:**
• Disable the Crossfade Songs preference in iTunes
• Disable the Sound Enhancer preference in iTunes
• Disable the Sound Check preference in iTunes
• Disable Sleep and other Energy Preferences.

**Issue:**
Amarra does not play audio.

**Solution:**
• Files may not play if the Permissions are not set to Read / Write. Check the permissions and ensure Read/Write and access privileges.

**Solution:**
• Files may not play if the path is too long or contains non-ascii characters. Try moving the files to another location.

**NOTE:** Sound files with names that contain “;” or other foreign characters may not play properly. Changing the name of the soundfile can fix this.

**Issue:**
Sample Rate Does Not Change With Soundfile.

Does your device support the sample rates for your music? Amarra Junior will only support 44100 Hz files. Otherwise, iTunes will be used (and sample rate conversion may occur).

**10.0 Support ::**
We are committed to your successful use of Amarra and offer support for Amarra Junior through your local dealer or via email through Sonic Studio. Please ask your local dealer for assistance. They have a great deal of knowledge about Amarra Junior and are an excellent resource.
11.0.0 Amarra Team Contact Info ::

Please email support with questions.

support@sonicstudio.com

You can always find the latest information and updates for Amarra Junior on our website:

http://www.amarraaudio.com